
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

IK/FK Switch : Rigging 
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Copyright and Terms of Use 
Please leave all references to FridgeMonsters intact in the documentation and 
code examples.  
 
1. Except as otherwise provided, the contents of these notes shall not be 
reproduced, republished, uploaded, posted, transmitted or distributed 
electronically or non-electronically in any way, without FridgeMonsters prior 
written permission. 
 
2. Modification of any of the contents or use of the contents for any other purpose 
will be a violation of FridgeMonsters copyright and other intellectual property 
rights. Graphics and images in these notes are protected by copyright and may 
not be reproduced or appropriated in any manner without written permission of 
FridgeMonsters. 
 
3. FridgeMonsters reserves all rights to deny or restrict access to these notes to 
any particular person or persons, or to block access from a particular Internet 
address to the FridgeMonsters.com Web Site, at any time, without ascribing any 
reasons whatsoever. 
 
4. These Terms of Use shall be governed and construed in accordance with laws 
of the Republic of Singapore. 
 
For full details, please view the Terms of Use document at :  
 
http://www.FridgeMonsters.com/administration/terms.asp 
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Introduction 
The objective of this tutorial is to Rig a set of arm Joints that can switch 
(transform) smoothly from IK to FK and back again at any point in your 
animation, depending on the requirements of the animation.   
 
Learning Outcome 
The objective of this tutorial is to introduce you to the following :  
 

1. Create a Joint Chain to Rig an Arm. 
2. Create IK handles for the Joint Chain. 
3. Create Control Objects. 
4. Duplicating Joint Chains.  
5. Orient Constraint 
6. Point Constraint 
7. Parent Constraint 
8. Pole Vector Constraint 
9. Parenting 
10. Add Attributes 
11. Set Driven Keys 
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Setting the Project 
The Project folder contains all the sub-folders for your project. It allows your 
scene to source for all the appropriate files and references in an organised 
manner. 
 
New Project 
File > Project > New 

1. Name the Project 
2. Location to Save the Project 
3. Set Folder Names 

 
Name the Project : lower case character, obvious names with no spaces 
Location of Project : The default location is set to Documents Folder, but if you 
are not working on your own computer it’s better to save it to the Desktop. Copy 
this Project folder to your portable device when you have finished this tutorial. 
 
Do not save your project to a portable drive (thumb drive) or the performance 
will lag. 
 
 

 
 
Name your project : ikfk_switch. Click the Use Defaults button to set the Project 
Data Locations. Then click Accept. 
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Introduction 
The objective of this tutorial is to create an IK/FK Switch. In this example the 
IK/FK Switch will be used on a simple arm and allow the arm to be switched 
between IK and FK mode at any time during the animation.  
 
To create and IK/FK Switch, 3 sets of Joints are required in the same location. 
Take a look at the diagram below. The 3 sets of Joints are separated out to make 
understanding this tutorial easier. 
 
The actual Skeleton (Main) used to control the model of the character is in the 
middle. The IK Joint are at the top of the diagram and the FK Joints are at the 
bottom. 
 
Notice that the IK Joints (top) have a single Control Object (NURBS Circle) at the 
end of the IK Chain, on the wrist. The IK Control Object is moved (translated) 
around and the IK Joints will follow. The IK Joints also has a Control Object for 
the orientation of the elbow.  
 
The FK Joints (bottom) have a Control Object on each Joint as each Joint is 
rotated into position individually.  
 
The Main Joints remain in their original position, still connected to the Clavicle 
bone (and the main skeleton). There is a Control Object (NURBS Circle) at the 
end of the Main Joints with an Attribute (IK_to_FK_switch) to allow you to change 
the Weight of influence between the IK Joint and FK Joints. 
 

 
Joints separated out for tutorial purpose only.  
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Simply put, you are making an IK arm and an FK arm to add to your Main 
Skeleton. You can then animate using either the IK or FK arms. The Main Joints 
will then follow either the IK arm or the FK arm as you define the weightage of 
influence.  
 
Suppose you need to change from using the FK arm to IK arm (or visa versa) in 
your animation. If you simply changed the weightage of influence in 1 frame, the 
Main Joints would instantly jump from FK arm position to the IK arm position. To 
prevent any possible jump or “popping” in the animation, the IK/FK Switch 
covered in this tutorial will allow you to animate a seamless transition between 
the IK and FK positions. 
 
WARNING : If you are referring back to these notes at a later date, it is 
extremely important to remember that the IK/FK Switch should be applied after 
Binding the Skin to the Skeleton. If you create the IK/FK Switch before you Bind 
the Skin, the extra IK and FK Joints and Bones will effect the Skin.   …..Be 
Warned..!!  
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[1] Building the Skeleton 
In the Top view create a simple arm Skeleton setup using 4 Joints (3 bones) to 
create a Clavicle, Shoulder, Elbow and Wrist 
 
 

Animation Mode > Skeleton > Joint Tool 
 

 
 
 

Remember to RESET the Joint Tools.  
 
 

 
 
 
Lay the Joints out from Left to Right, even spaced. Press Enter when you have 
finished.  
 
Note : You can lock the position of the Joints Vertically or Horizontally by holding 
the Shift key down as you click. 
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Open the Outliner and name the Joints as indicated in the diagram below.  
 
 Window > Outliner 
 

 
 
In the Top view, adjust the elbow Joint by moving it backwards as though the 
arm is slightly relaxed. 
 
 elbow > W Key (translate) > local axis (PC=Insert : MAC=Home) 
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In the Front view, adjust the clavicle Joint by moving it slightly lower than the 
shoulder Joint. 

 

 
 

After you have adjusted the position of the Joints it is necessary to make sure all 
the necessary axis are re-align and pointing in the correct direction before you 
start rigging.  
 
 Animation > Skeleton > Orient Joint > Options 

 

 
 

 
Reset the options and ensure the Orientation option is set to XYZ.  
 
Note : The Orientation option allows you to select various combinations of XYZ. 
In each combination the first letter is the axis which will be aimed down the Joints 
Chain from one Joint to another. The second letter defines the “up” direction, and 
the third axis is simply the remaining axis – normally the axis around which you 
rotate the Joint. 
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That’s it – The Main set of Joints are now complete. The objective now is to 
Duplicate the Joint Chain from the Shoulder to the Wrist and then 
Disconnect the new Joint Chains from the Clavicle. This needs to done twice so 
that you have the original Joints plus 2 duplicates – 1 for the FK arm and 1 for 
the IK arm. 
 
Note : Read the explanation above again to get a clear understanding of the 
intended outcome and why you are completing the following steps before you 
start.  
 
 
[2] Creating the FK and IK Joints Chain 
Select the shoulder Joint and Duplicate it twice.  
 
 Edit > Duplicate (Ctrl + D) 
 

 
 
 

Note : It’s probably a good idea to RESET the Duplicate Tool before Duplicating 
– just to be safe.  
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Take a look in the Outliner. You should have a single Clavicle Joint and 3 
shoulders joined to it.  
 

 
 

Re-name all the joints by using the Prefix Hierarchy Tool. Select a shoulder in 
the Outliner, open the Prefix Hierarchy tool and enter the prefix. This will 
append (add) the prefix to the beginning of the names of all the Joints beyond 
the shoulder currently selected. 
 
 Modify > Prefix Hierarchy Names… > enter the prefix & an underscore (_) 
 
 

 
 
Name the 3 sets of arms joints as follows… 
 

FK = fk_shoulder > fk_elbow > fk_wrist 
Main = main_shoulder > main_elbow > main_wrist 
IK = ik_shoulder > ik_elbow > ik_wrist 

 
Note : You may need to remove the numerical suffixes from the shoulder Joints. 
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Extend [+] the Outliner view and check the labelling against the diagram below.  
 
 

 
 

 
[3] Separating and Disconnecting the IK Joint and FK Joint 
Visually separate the main, ik and fk Joints by selecting the ik_shoulder and 
fk_shoulder Joints up and down respectively.   
 

ik_shoulder > W Key (translate) > local axis (PC=Insert : MAC=Home) 
 
Move (Translate) ik_shoulder up. 
 

fk_shoulder > W Key (translate) > local axis (should already be active) 
 
Move fk_shoulder down. 
 
 

 
 

 
As you can see, the ik_shoulder Joint and fk_shoulder Joint are still connected to 
Clavicle Joint.  

 
 

 

www.FridgeMonsters.com Page 13 Chris Shaw 



Remove the connections (bones) to the ik_shoulder Joint and fk_shoulder Joint by 
selecting each Joint and Disconnecting Joint. 
 
 Animation > Skeleton > Disconnect Joint 

 
 

 
 
 
 

When you Disconnect a Joint a new Joint is placed in the same place to preserve 
the bone. Select 2 new Joints in the Outliner and Delete them.  
 

 

 
 
 

 
At this point you should have the original set of main Joint PLUS a set of arm 
joints for IK (above) and a set of joints of FK (below). See the diagram below.  
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[4] Add the IK Handle  
The next thing you need to do is add the IK Handle to the IK Joints.  
 

Animation > Skeleton > IK Handle Tool > Options 
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Reset the IK Handle Tools. Set the Current Solver to a Rotation Plane Solver. 
 

 
 
 

Create an IK Handle from the ik_shoulder to the ik_wrist. 
 

 

 
 
 

[5] Constraining main Joints(middle) to IK(above) and FK(below) Joints 
The object here is to get the main Joints to follow the orientation of the IK 
Joints and FK Joints.  
 
To apply an Orient Constrain, first select FK Joint, then IK Joint and finally the 
Main Joint (select the Commanders first and the Soldier last).  
 
Follow the steps below to apply and Orient Constraint to the main_shoulder, 
main_elbow and main_wrist Joints. 
 

Select fk_shoulder > ik_shoulder > main_shoulder > Constraints > 
Orient (Maintain Offset ON). 
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Select fk_elbow > ik_elbow > main_elbow > Constraints > Orient 
(Maintain Offset ON) 

 
Select fk_wrist > ik_wrist > main_wrist > Constraints > Orient  
(Maintain Offset ON) 

 
 

 
 
At this stage the orientation of the main Joints is controlled 50% by the FK Joints 
and 50% IK Joints 
 
Note : Open the Outliner to check if the Orient Constraints have been applied 
correctly. Select main_shoulder joint. Notice main_shoulder now has an Orient 
Constrain Node ( ! main_shoulder_orientConstraint1). Select the Constraint Node 
and have a look at the Channel box - It should have 2 weight input Attributes – 
ik_shoulder W0 and fk_shoulder W1.  

 
 

 
Check that main_elbow and main_wrist also have Orient Constraint Node have 2 
weight input Attributes (As shown above).  
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The values are both set to 1 meaning the Orientation of main_shoulder is 
equally weighted between the ik_shoulder Joint and fk_shoulder Joint.  
 
The objective is to create a switch that will allow you to smoothly transform from 
IK to FK and back again at any point in your animation.  

 
[6] Create an Switch Controller (IKFK_controller) 
Create a NURBS Circle to use as a Control Object. Positioned the Control Object 
on main_wrist. Renamed the Control Object IKFK_controller. Add an Attribute 
to IKFK_controller called IK_to_FK (minimum value 0 – maximum value 10). 
The IK_to_FK Attribute will allow you to switch the weightage of the main Joints 
between IK and FK Joints.   
 

Shelf > Curves > Circle 
 

 

 
Move (Translate) the NURBS Circle and snap it to the main_wrist Joint. Rotate the 
NURBS Circle 90° 
 
 

 
 
 
Note : Move + V key to snap to main_wrist Joint. Circle appears at the centre of 
the axis, click in the circle and drag it to main_wrist joint.  
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Delete the History  
 
 

 
 
 

Freeze the Transformations 
 

 

 
 
Name the NURBS Circle > IKFK_Controller 
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Select IKFK_Controller. Open the Channel Box and RMB on the list of 
Attributes. Select Add Attribute.  
 
Enter the values as indicated in the diagram below.  
 
 

 
 
 
Note : Minimum 0 means the IK is fully enabled (FK is disabled). Maximum 10 
mean FK is fully enabled (IK is disabled).  

 
 

 
 

[7] Set Driven Key 
The objective now is to define and set key values for the IK_to_FK_Switch 
Attribute and match them with values for the Orientate Constraint values.  
 
Open the Set Driven Key dialogue box… 
 

Animation > Animate > Set Driven Key > Set 
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The IKFK_Controller has the newly define IK_to_FK_Switch Attribute. Load the 
IKFK_Controller as the Driver and select the IK_to_FK_Switch Attribute. 
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Access the Channel Box and set the IK_to_FK_Switch value to 0. 
 

 
 
You now need to set the weightage values for main_shoulder, main_elbow and 
main_wrist. When the IK_to_FK_Switch is set to 0, the weightage should be 
100% towards the FK Joints and 0% towards the IK Joints. 
 
Open the Outliner and Expand [+] main_shoulder. Select all 3 orientConstraints 
and click Load Driven. 
 

 
 
 
The objective now is to set all 3 Orient Constraints values to 0 for IK and 1 for 
FK.  
 
Select main_shoulder_orientConstraint1 in the Driven window. Then select 
ik_shoulderW0 and fk_ shoulderW1.  
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In the Channel Box, change the values of ik_shoulderW0 and fk_shoulderW1. 
 

ik_shoulderW0 = 0 
fk_shoulderW1 = 1  

 

 
 
 
Click Key to set the values. 
 
Follow the steps below to repeat these steps above and set the Orient 
Constraint for Elbow and Wrist also in favour of fk_shoulderW1 
 
Select main_elbow_orientConstraint1 in the Driven window. Then select 
ik_elbowW0 and fk_shoulderW1 from the list of Attributes.  
 
In the Channel Box, change the values of ik_elbowW0 and fk_elbowW1. 
 

ik_elbowW0 = 0 
fk_elbowW1 = 1  
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Click Key to set the values. 
 
Select main_wrist_orientConstraint1 in the Driven window. Then select 
ik_wristW0 and fk_wristW1 from the list of Attributes.  
 
In the Channel Box, change the values of ik_wristW0 and fk_wristW1. 
 

ik_wristW0 = 0 
fk_wristW1 = 1  

 
 

 
 
Click Key to set the values. 

 
The objective now is to set the IK_to_Switch value to 10 and the Orient 
Constraint for main_shoulder, main_elbow and main_wrist to favour IK Joint 
Chain. 
 
Select the IKFK_Controller and in the channel box set the IK_to_FK_Switch 
value to 10.  
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Now set all 3 Orient Constraints to 1 for IK and 0 for FK.  
 
Select main_shoulder_orientConstraint1 in the Driven window. Then select 
ik_shoulderW0 and fk_shoulderW1 from the list of Attributes.  
 
In the Channel Box, set the values of ik_shoulderW0 and fk_shoulderW1. 
 

ik_shoulderW0 = 1 
fk_shoulderW1 = 0  

 

 
 
Click Key to set the values. 

 
Select main_elbow_orientConstraint1 in the Driven window. Then select 
ik_elbowW0 and fk_shoulderW1 from the list of Attributes.  
 
In the Channel Box, change the values of ik_elbowW0 and fk_elbowW1. 
 

ik_elbowW0 = 1 
fk_elbowW1 = 0  
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Click Key to set the values. 
 
Select main_wrist_orientConstraint1 in the Driven window. Then select 
ik_wristW0 and fk_wristW1 from the list of Attributes.  
 
In the Channel Box, change the values of ik_wristW0 and fk_wristW1. 
 

ik_wristW0 = 1 
fk_wristW1 =0  

 

 
 
Click Key to set the values. 
 

 
Note : You will no longer animate any of the Joints in the main Joints Chain. 
Instead you will decide if you need IK or FK functionality to animate. You will then 
select the IKFK_Controller object (NURBS circle) and set the 
IK_to_FK_switch value to either 0 (IK) or 10 (FK).  
 
Having the values 0 to 10 for the IK_to_FK_switch allows you to gradually switch 
from the IK Joints to the FK Joints without jumping or “popping”.  
 
In the Outliner, select the ik_shoulder and notice that main_shoulder is now 
Pink. This indicates that main_shoulder is Constrained in some way to 
ik_shoulder. 
 
Now select fk_shoulder and notice that main_shoulder is still Pink. This 
indicates that main_shoulder is Constrained in some way to fk_shoulder. 
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[8] Create controllers for FK and IK 
 
Using a NURBS Circle, create 5 control objects and shown the diagram below. 
 

 
 
 
Name them as follows…  
 

1. ik_arm_control 
2. ik_elbow_pole_control (this control object is used to control the elbow 

position, so it is placed behind the elbow) 
3. fk_shoulder_control 
4. fk_elbow_control 
5. fk_wrist_control 

 
Delete the History and Freeze Transformations. 
 
IK Arm Rigging 
 

1. Select ik_arm_control and then select the IK Handle (arm_ik). Apply a 
Point Constraint. 

2. Select ik_arm_control and then select ik_wrist. Apply an Orient 
Constraint. 

3. Select ik_elbow_pole_control and then select the IK Handle (arm_ik). 
Apply a Pole Vector Constraint. 

 
FK Arm Rigging 
 

1. Select fk_shoulder_control and then select the fk_shoulder. Apply a 
Parent Constraint. 

2. Select fk_elbow_control and then select the fk_elboe. Apply a Parent 
Constraint. 

3. Select fk_wrist_control and then select the fk_wrist. Apply a Parent 
Constraint. 

4. Parent (P Key) fk_wrist_control to fk_elbow_control to 
fk_shoulder_control to clavicle  
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Main Arm Rigging 
 

1. Select main_wrist and then select the IKFK_Controller. Apply a Parent 
Constraint. 
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